
Introduction
While symbols and colors on a geologic map give insight 

to the geology of a region, it is the shaded relief that reveals 
the geomorphology of the terrain. Creating a true-to-form 
image of a landscape’s terrain has been a challenge for 
cartographers for centuries. Portraying three-dimensional 
surfaces on a flat piece of paper can only be done by tricking 
the eye (Thelin and Pike, 1991). This can be done with careful 
and suitable positioning of a light source. By introducing just 
the right position of a light source and the height in which 
light strikes the landscape, the illusion of depth in the terrain 
is created.

However, in applying a light source against elevation 
data, the generated shadow effects of shaded relief can be 
troublesome when adding colored thematic maps such as 
geologic maps. Detail in the shaded relief is defined by 
shadows, resulting in dark hues of gray and black pockets in 
ridges of mountains that will alter any color that is overlain. 
For example, Quaternary geologic map units that are typically 
shades of yellow appear muddy and greenish when placed 
over a highly detailed image of shaded relief. All colors are 
directly affected by the shaded relief, making them appear 
darker than their original hue. The challenge is to create 
shaded relief that retains detail through shadows and light 
application yet is faint enough to overlie a geologic map 
without misrepresenting the true hue of the geologic map 
units.
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To enhance the shaded relief while preserving the original 
colors, the Idaho Geological Survey has developed a process 
for creating shaded relief from Digital Elevation Models 
(DEM). We developed a semi-standardized method using 
ESRI ArcMap (http://www.esri.com) and Adobe Photoshop 
(http://www.adobe.com) to create crisp hillshades to add 
detailed shaded relief to our geological maps without compro-
mising the colors of the units.

Early Trials
Before establishing a new method of generating shaded 

relief, we decreased the opacity of the hillshade image in 
Adobe Illustrator during the layout process of map production. 
This gave us the results we were looking for in regards to 
matching the colors on the map to the geologic map units but 
presented us with yet another problem. Simply making the 
image more transparent faded the detail of the shaded relief. 
In another effort to lighten the hillshade, the brightness and 
contrast of the image were altered in Adobe Photoshop but 
resulted in the same faded appearance. It became apparent that 
more steps were needed in order to generate the hillshade in 
ArcMap, before the shaded relief was brought into the layout 
stage of map production. The idea was to create a single 
shaded relief image with multiple light sources to bring in 
more detail and reduce the saturation of dark shadows.
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A New Method of Building Shaded 
Relief

Hillshades

The first step of the new process begins with creating 
three new hillshades from the DEM file in ArcMap, each with 
a different origin of light. The hillshades are created using the 
Hillshade tool found in the extension Spatial Analyst toolset, 
under the Surface Analysis menu. The light source is deter-
mined by the azimuth and altitude; azimuth is the illumination 
direction, and altitude is the illumination angle. The azimuth is 
a measurement between 0 and 360 degrees in which 0 is north, 
90 degrees is east, 180 degrees is south, and 270 degrees is 
west. Light sources coming from the east and south will cause 
topography to look reversed. Values that are more northerly 
and (or) westerly are preferred. The altitude is a measurement 
in degrees of the light source position relative to the horizon. 
With an altitude value of 0 degrees, the light source is set at 
the horizon, whereas a value of 90 degrees sets the light source 
directly overhead. Using an altitude from directly overhead 
will make flat regions appear like an overexposed photograph, 
eliminating any detail in flatter regions, while using values 
closer to the horizon will make the landscape extremely dark, 
casting large black shadows around any topographic feature 
with significant elevation. Another important factor in creating 
the hillshade is the vertical exaggeration, which enhances 
the appearance of depth in the terrain. This is determined by 
the z factor, which is a multiplier of the z values (elevation). 
The higher the z factor, the more exaggerated the depth of the 
terrain will appear. 

After experimentation with different azimuth, altitude, 
and z factor values, we have developed a suggested value 
set for creating hillshades. The transparencies of the three 
hillshades we create are then each adjusted individually. 
Varying the transparency values of the three hillshades allows 
the different topographic details accentuated by each hillshade 
to be seen in one image. Dark shadows that exist in a single 
hillshade are compromised by the presence of light in another 
hillshade. The hillshades that have darker shadows are made 
to be slightly more transparent than those with lesser shadows. 
The result is a more balanced image (fig. 1). An example of 
the values for the azimuth, altitude, and transparency we use 
is shown in table 1. The order in which the hillshades are 
layered is determined by the light and dark qualities of the 
hillshades. The hillshade with the lightest qualities are placed 
on top. When the transparencies are set, the image is ready to 
be exported from ArcMap. The image is saved as a tiff file so 
that it can be opened in Adobe Photoshop for the next steps of 
the process.

It is important to keep in mind that each DEM file needs 
its own special attention to bring out the detail desired by the 
cartographer. Different terrain types may benefit from alternate 
light sources and therefore these values used by the IGS 
should be considered as a guideline. It is also a good practice 

to experiment with different transparency levels for each 
hillshade. 

Adobe Photoshop

Although the shaded relief created by layering the three 
hillshades in ArcMap does result in an image with fewer dark 
shadows, more can be done to improve the detail of the image 
and make it even lighter. In Photoshop there are several tools 
to manipulate the image to modify the highlights and shadows 
within the terrain. These tools can be found in the Image menu 
under Adjustments. 

Shadows and Highlights Tool
We start with the Shadows/Highlights settings to further 

modify the shaded relief. The Shadows/Highlights settings 
lighten and darken the image on the basis of the surrounding 
pixel values. This property of the tool allows the cartographer 
to highlight details by emphasizing feature characteristics 
separately, as the shading that is applied is based on the 
individual pixel values rather than application of uniform 
shading to the entire image. The Shadows/Highlights dialog 
box uses sliders to make the adjustments and has a preview 
option so that the values applied can be seen immediately in 
the image.

The first setting in the dialog box is Shadows, which 
will alter the dark areas of the image (fig. 2). We set the slider 
in the higher percentage range, between 75 and 90 percent. 
The dark shadows added can be modified using the Tonal 
Width and Radius sliders. The Tonal Width adds a control on 
the adjustments being applied by setting a range to restrict 
how much modification occurs. We set the Tonal Width to a 
high value, between 80 to 95 percent, thereby restricting the 
adjustments to lighten just the darker regions. The Radius 
setting determines the extent of how many surrounding pixels 
will be affected by the adjustments. We set the Radius of the 
shadows setting between 35 and 200 pixels. The radius of the 
shadow setting is dependent on the diversity of elevation in 
the hillshade. Areas with lower elevations should get higher 
radius values to capture the small details of terrain features, 
whereas hillshades dominated by higher elevations should get 
lower values to ensure that fewer pixels are included in the 
adjustments, in order to prevent the addition of too many dark 
shadows.

Table 1.  Example values for azimuth, altitude, and 
transparency for building hillshades. Each hillshade is given 
the same vertical exaggeration value (z factor=2).

Hillshade Layer 
Sequence

Azimuth Altitude Transparency

Top 350° 70° 65%
Middle 15° 60° 50%
Bottom 270° 55° 70%
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The Highlight settings complement the Shadows settings 
by processing only the light regions of the image. Increasing 
the percentage of the Highlight setting will darken the image, 
thereby showing more detail by accenting low-relief features. 
This is especially important in the lower elevations, where 
detail is harder to see in the original image. Adjusting the 
highlights also gives the shaded relief a smoother appearance. 
We typically keep our Highlight setting low to prevent the 
image from getting too dark. We set the Highlight between 
5 and 20 percent. The Tonal Width of the highlight settings 
works the same as the Tonal Width of the Shadow settings, but 

on the opposite spectrum. We set the Tonal Width in a lower 
range from 5 and 20 percent, to lighten the image. The Radius 
of the Highlight settings is set to the same value as the Radius 
of the Shadow settings.

The last options in the Shadows/Highlights dialog box are 
the Brightness and Midtone Contrast. Changing the brightness 
and contrast too much can result in a loss of the detail created 
by the previous steps. We only brighten the image slightly 
and decrease the contrast slightly when working through 
the Shadows/Highlight adjustment tool. We typically set the 
brightness to about +15 and the contrast to -5.

Figure 1.  The three hillshades shown on the top row were created in ArcMap with different light sources. Their 
azimuths and altitudes are typically used by the IGS for these applications. The image on the bottom displays the 
three hillshades layered together, with their transparency settings optimized.
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Exposure
To lighten the image we use the Exposure tool found in 

the Image menu in the Adjustments drop down list (fig. 3). 
The Exposure tool allows more control in lightening the image 
than the Brightness and Contrast tools because it is based on 
calculations in the gamma spectrum. In the Exposure dialog 
box there are three values that can be specified—exposure, off-
set, and gamma. The exposure value adjusts the highlights of 
the image with very little effect on the shadows in the image. 
The offset value alters the shadows’ midtones, with minimal 
effect on the highlights in the image. The gamma value uses a 
power function so that negative values are adjusted as if they 
were positive. To find the optimal adjustment, a sliding scale 
is used for each value. We set the exposure slightly toward the 
negative side, but no farther than -0.50. The offset is pushed 
toward the positive side, but no more than +0.30. We set the 
gamma to a value greater than 1, but no greater than 1.5.

Setting Levels
If the image still has dark areas even after using the 

Exposure tool, we use the Levels tool to change the grayscale 
of the shaded relief (fig. 4). The Levels tool is found under the 
Image menu in the Adjustments menu. In the Levels dialog 
box, the input and output values of the color ramp can be 
changed. The input values stretch the tonal range, which is 
defined by the output levels. As the default, the values are 

set to 0 for black and 255 for white. With the preview box 
checked, the value alterations can be seen in the image. To 
eliminate black areas in the image, the output value can be 
changed using a grayscale range from black (value of 0) to 
white (value 255). We usually set the black side of the range to 
a value from 20 to 80 in order to tone down the black values in 
the image.

To lighten the image even more, adjustments to the input 
levels can be altered, between 0 and 255. Three values that can 
be changed on the input grayscale—we set them to about 0, 
1.40, and 215. The sliding scale under the input bell curve is 
helpful in finding the right balance of grayscale input values 
for the shaded relief. The image is then saved with a new name 
so that the original is not altered. Figure 5 shows the final 
results of creating shaded relief using multiple light sources 
and the Photoshop imagery tools, compared to our previous 
method of creating a single hillshade in ArcMap.

Figure 2.  Dialog box for the Shadows/
Highlights tool in Adobe Photoshop, 
showing the slider values used to adjust 
the image.

Figure 3.  Dialog box for the Exposure tool in 
Adobe Photoshop, showing the slider values 
used to adjust the image.

Figure 4.  Dialog box for the Levels tool in Adobe Photoshop, 
showing the slider values and grayscale bell curve used to 
adjust the image.
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Overlaying Color
The shaded relief image is now ready to be inserted 

into an Adobe Illustrator document, where the geologic map 
units will be combined with the shaded relief. The shaded 
relief should be inserted using the Place command located 
in the File Menu of Adobe Illustrator, into a new layer, under 
the geology color layer. Once the two images are overlain 
and aligned correctly, the colorized geology layer is set to 
Multiply. The Multiply option can be applied by selecting 
the entire geology layer and clicking on Multiply from the 
drop-down box in the Transparency window. The colored, and 
multiplied, geologic units over the shaded relief can be seen in 
figure 6, using both our previous method of generating shaded 
relief and the method described in this paper. If the shaded 
relief is still found to alter the color scheme of the map units, 
the Opacity can be changed to about 85 percent to lighten the 
image.

Creating shaded relief for geologic maps is an extremely 
difficult task. Finding the right angle and height for light 
sources is only the first hurdle. At the Idaho Geological 
Survey, we have been adding shaded relief to our geologic 
map publications for several years and are still working to 
find the quickest and most efficient way to present shaded 
terrain along with symbolization of data. Unfortunately, 
each DEM requires unique attention to its detail, in order to 
properly consider the position and physical characteristics 
of mountains, valleys, and other landscape features when 
changing elevation data to a three-dimensional image. All the 
values used in this paper should be considered as suggestions 
to begin the process. Although our process is a lot of work and 
requires many steps, the shaded relief created has allowed the 
colors of our geologic map units to retain their true hues.

Figure 5.  Imagery tools in Adobe Photoshop give the cartographer more control when modifying the highlights 
and shadows in a shaded relief image. With a combination of these toolsets and illumination from three different 
directions, the shaded relief created is still distinct in detail yet light in saturation. The image on the left is an 
example of our new method using multiple light sources and Photoshop imagery adjustment tools to produce 
shaded relief. The image on the right is an example of our previous method using one hillshade with one light 
source. The shaded relief on the right has more dark shadows and overexposed areas resulting in an image 
lacking in overall detail. The region labeled “A” is an example of how black shadows are reduced in Photoshop. 
The region labeled “B” demonstrates the loss of detail where features are overexposed to light using only one 
light source (right image), whereas the image with multiple light sources (left image) retains more detail.
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Figure 6.  In these two images, the geology has been placed over the shaded relief that was 
created using our new method (image on the left) and our previous method (image on the right). In 
the image on the right, the geologic map unit colors have been altered by dark shadows. The area 
labeled “A” shows how dramatic this alteration is. The area labeled “B” is an example of how light 
unit colors are affected by the poor lighting. The light green appears more muddy and looks like 
a darker green than the original unit color. The image on the left shows these areas closer to the 
original map unit hue with only slight alterations caused by the light gray shadows of shaded terrain.
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